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1. Introduction

About Dorling Kindersley
DK Multimedia titles are available wherever CD-ROMs are sold. New
titles will be available on a regular basis. For more information, 
contact us at DK Multimedia, 9 Henrietta Street, London, WC2E 
8PS.

You may also visit us on the World Wide Web at:

http://www.dk.com

About this Read Me file
The information in this file is designed to address most of the
problems you may encounter when using any multimedia title. If
you are having problems with The Ultimate Human Body 2.0 (Body 
2.0), please take a look at the items listed in the table of contents to 
see if your particular problem is addressed. If you are still having 
problems, please call our technical support number with details of 
the problem including any error messages that were produced and 
the full specification of your computer.

The numbers in New York, USA are:

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: DKMM@phantom.com

The numbers in London, United Kingdom are:

Telephone: 0171 753 3488
Fax: 0171 753 7575



E-mail: DKMM@DKMM.CO.UK

To move around this file, press Page Up and Page Down, or click
in the vertical scroll bar. You can print this file by selecting the
Print command from the File menu.

More help on making the best use of all the features within
Body 2.0 is available once you have started the product. Click on the
help icon on the right-hand side of the console. Click on ‘Having 
Problems?’ to access more information (you will also find a reminder 
of some of the main points in this document.)

2 Setup and Uninstall notes

2.1 Minimum system requirements

In order to run Body 2.0 you will require a multimedia computer with 
the following minimum requirements:

A multimedia PC, with 486DX/33MHz or higher microprocessor, 8Mb 
RAM (12Mb recommended for Windows 95), MPC-compatible 
double-speed CD-ROM drive and sound card, mouse, SVGA 640 x 
480 pixel 256 color display (16 bit colors preferred), loudspeakers or 
headphones, and Microsoft Windows 3.1x or Windows 95.

2.2 If Setup fails with an error message

If the Setup program fails with an error message you should ensure 
that no other programs are running while you try to install Body 2.0. 
You can check this by pressing CTRL + ESC in Windows 3.1/3.11 or 
by pressing ALT + TAB in Windows 95.

If Setup fails with an error message indicating a ‘General Protection 
Fault’ or ‘Cannot change properties of...’ then
you should check whether Norton AntiVirus software, or any other
virus checking software, is installed on your machine. It is
recognized that the presence of Norton AntiVirus, and certain
other virus checking software, causes problems with the
Body 2.0 Setup program. To overcome problems with Norton 
AntiVirus, type the letters ‘REM’ (followed by a space) at the 
beginning of any lines that have the text ‘NAV’ in them in the 
‘AUTOEXEC.BAT’ and the ‘CONFIG.SYS’ files. Also, type a 
semicolon ‘;’ at the beginning of the line containing the ‘LOAD =‘ 
entry in the ‘WIN.INI’ file. (The letters ‘REM’ at the beginning of a line



in the ‘AUTOEXEC.BAT’ and ‘CONFIG.SYS’ files, and the semicolon 
at the beginning of a line in the ‘WIN.INI’ file, cause the line to be 
ignored.) You can edit these files by choosing ‘File’ then ‘Run’ from 
the ‘Program Manager’ in Windows 3.1/3.11 or by choosing ‘Run’ 
from the ‘Start’ menu in Windows 95. Once you have selected ‘Run’ 
you should type ‘SYSEDIT’ in the text box, and press return. You can
choose the file you wish to edit from the ‘Window’ drop-down menu. 
Once you have edited the files and saved your changes you should 
exit Windowsâ and restart your computer, then try to run Setup 
again. Similar steps can be taken to overcome problems with other 
virus checking software.

Put these changes back once the Setup program is complete and 
Body 2.0 is successfully installed on your computer. 

2.3 Setup for Windowsâ 95 users

If you are running Windowsâ 95, Body 2.0 can take advantage of 
AutoPlay, which should automatically start the installation procedure 
when you insert the disc into your CD-ROM drive. Body 2.0 should 
also run automatically when the CD is placed in the CD-ROM drive 
subsequent to the initial Setup. If the installation procedure does not 
automatically start, or the Body 2.0 program does not automatically 
run when the disc is inserted in the CD-ROM drive, then you should 
first check that AutoPlay is enabled. To do this:

1. Go to the ‘Start’ menu and choose ‘Settings’, then ‘Control
Panel.’

2. Choose ‘System’ from the ‘Control Panel’ to bring up a ‘System
Properties’ window.

3. Choose the ‘Devices Manager’ tab, and select your particular
CD-ROM drive from the CD-ROM device list.

4. Click the ‘Settings’ tab in this window, and ensure that ‘Auto
Insert Notification’ is checked.

If Auto Insert Notification is checked, and Setup does not start 
automatically the first time you insert the Body 2.0 CD in the drive, 
then you can start the Setup program manually. To do this, go to the 
‘Task Bar’ and click on ‘Start’, then ‘Run.’ Type ‘D:\SETUP’ in the text
box (where D is the letter of your CD-ROM drive.) Click ‘OK’ and 
then follow the instructions that appear on your screen. On 
subsequent occasions the Body 2.0 program can also be run from 



the ‘Start’ menu by selecting ‘Programs’, then ‘DK Multimedia’, then 
by double-clicking on The Ultimate Human Body 2.0. You should also
contact your CD-ROM manufacturer for the latest drivers.

2.4 Uninstall

The Body 2.0 CD-ROM contains an Uninstall program which is 
automatically installed in the DK Multimedia program group on your 
computer. If you decide that you no longer wish to have Body 2.0 on 
your computer, you can use Uninstall to remove it. Simply double-
click on the ‘Uninstall’ icon to display a list of titles on your computer 
that can be uninstalled. Highlight the titles you wish to uninstall, then 
click the ‘Delete’ button. Uninstall does the rest for you!

2.5 Running Body 2.0 with Windows 95

2.5.1 The Task Bar

The Task Bar in Windows 95 may force Body 2.0 off the screen, 
meaning that not all of the Body 2.0 screen is visible. This happens 
because Windows 95 tells all programs the screen is actually smaller
than it is, so that they do not cover the Task Bar. The full Body 2.0 
screen may be viewed by selecting the edge of the Task Bar with the 
left mouse button and dragging it out of sight before running Body 
2.0. Alternatively, right-click on an empty area of the Task Bar, then 
click on ‘Properties’ using the left-hand mouse button and turn on the
‘Auto Hide’ option.

Changing to a higher screen resolution will also solve this problem.

3 Screen display notes

3.1 Screen resolution

DK Multimedia products have been designed to look their best with a
screen resolution of 640 x 480 pixels. All screen images are created 
in this size, and will completely fill the screen at this resolution. This 
means that running your screen at a higher resolution (such as 1024 
x 768) will result in a smaller image of Body 2.0 being displayed. (It is
NOT possible to maximize the product to fill screens with a resolution
higher than 640 x 480 pixels.)



3.2 256 colors

Body 2.0 uses 256 color images and we recommend that you set 
your display driver to 256 color mode or more. Windows 3.1/3.11 
users can run the ‘Windows Setup’ program from the ‘Main’ program 
group to identify their current driver display setting, and if necessary, 
to change their display driver. Windows 95 users can do this by 
choosing ‘Settings’ from the ‘Start’ menu, then by choosing ‘Control 
Panel.’ Double-click on the ‘Display’ icon, then click on the ‘Settings’ 
tab. Check the amount of colors your display is using in the ‘Color 
Palette’ scroll bar. 

If, for any reason, you select an incorrect or unsupported driver:

Windows 3.1/3.11 users
Go to the system prompt and change directory to your Windows 
directory by typing ‘C:’, then press ‘ENTER.’ Now type ‘CD C:\ 
WINDOWS.’ Press ‘ENTER’ again, then type ‘SETUP.’ You can now 
reinstall your original driver.

Windows 95 users
Start Windows in ‘Safe mode.’ Do this by holding down the F8 key 
when the ‘Starting Windows 95’ message appears on the screen. 
Choose ‘Safe mode’ from the menu. You can now reinstall your 
original driver.

        
3.3 Using more than 256 colors to improve video 
quality

You can improve the quality of videos in Body 2.0 by setting your 
display to use more than 256 colors (if this is supported by your 
computer.) However, this uses more memory and may result in a 
performance penalty. If this is the case, then we suggest you revert 
to 256 color mode. Instructions are given below for Windows 95 
users, and for Windows 3.1/3.11 users with Cirrus Logic and 
Diamond Stealth video cards, explaining how to change to more than
256 colors. All other users should refer to their video card 
documentation to do this.

3.3.1 Windows 95 users:

1. From the ‘Start’ menu, choose ‘Settings’, then ‘Control Panel.’
2. Double-click on the ‘Display’ icon. A ‘Display Properties’ dialog box

will appear.
3. Click on the ‘Settings’ tab.



4. Make sure that under ‘Desktop Area’, the figures below the slider 
control say ‘640 x 480 pixels.’ If this is not the case, move the 
slider until ‘640 x 480 pixels’ is displayed.

5. Under ‘Color Palette’, choose ‘High Color (16 bit.)’ If your video 
card and display support 24 bit color, you could select ‘True Color 
(24 bit)’ instead, however, this may result in an even greater 
performance penalty.

3.3.2 Windows 3.1/3.11 users with Cirrus Logic cards:

1. In ‘Program Manager’, double-click on the ‘VGA Utilities’ icon.

2. A ‘VGA Utilities’ program group should appear. It will contain either
a ‘SetRes’ icon or a ‘WinMode Utility’ icon, depending on the type 
of Cirrus Logic card you have. Double-click on this icon. If you do 
not have a ‘VGA Utilities’ icon then you should look for either a 
‘SetRes’ or ‘WinMode’ icon.

3. Select ‘640 x 480’ from the list of available screen resolutions.

4. Select ‘65536’ (16 bit) or 64K/65k, depending on what is 
displayed, from the list of colours available. Alternatively, you 
could select ‘16 Million’ (24 bit) if this option is available, however, 
this may result in a greater performance penalty. 

3.3.3 Windows 3.1/3.11 users with Diamond Stealth cards:

1. In Windows ‘Program Manager’, double-click ‘Windows
Control Panel’ in the ‘Main’ program group.

2. Double-click the ‘InControl Tools’ Diamond icon.

3. Select the ‘Display’ button to see options for color depth, and
select ‘65K high color’ mode.

3.4 16 colors

Body 2.0 is designed to run in 256 color mode or higher. If your 
computer is running in 16 color mode, and your display card 
supports 256 colors, you should change to 256 colors or more. This 
will enhance the image quality of Body 2.0. Instructions on how to do
this are given in section 3.3, Using more than 256 colors to improve 
video quality.



3.5 Images appear in monochrome

Some color display cards may display Body 2.0 images in black and 
white. If this happens, you should upgrade your color display driver. 
Contact the supplier or manufacturer of your display card to check 
that you have the latest display drivers.

3.6 Images are truncated

Some display drivers are designed to provide large fonts. If your 
system is using one of these, any image in the main window will 
appear slightly truncated. You can run the ‘Windows Setup’ program 
to change the default display driver to one that does not default to 
large fonts.

3.7 ATI cards

Some of the advanced features of ATI cards may be incompatible 
with Body 2.0. In particular, for the more powerful ATI cards, you may
find that the ‘256 color palette’ of the ‘ATI Control Panel’ must be set 
to ‘ON.’ For more information, see your display card documentation.

4. Problems with the display: animations, video 
and WinG

4.1 General problems

If you get an error message when you try to play video, you may not 
have the correct motion video drivers installed. During Setup, this 
special system software should have been installed, and Windows 
should be restarted afterwards to make this software work. If you did 
not restart Windows, do so before attempting to run Body 2.0 again. 

If video plays jerkily your system may have too little memory 
available to run video smoothly - consult Section 7, Running out of 
memory or running slowly, for further advice.

4.2 Solving problems with animation and video for 



Windows 95 users

If you are running Body 2.0 under Windows 95 and have problems 
with animation or video, for example jumpy video or distorted colors, 
there are three main steps you can try to solve your problems. Try 
the steps in the order given and stop when your problem is solved:

4.2.1 Ensuring your display is using 256 colors or more,
4.2.2 Checking your display adapter’s acceleration settings,
4.2.3 Changing your display adapter driver.

4.2.1 Ensuring your display is using 256 colors or more

1. From the ‘Start’ menu, select ‘Settings’, then ‘Control Panel.’

2. Double-click on the ‘Display’ icon, then click on the ‘Settings’ tab.

3. Check the ‘Color Palette’ setting to make sure that it is set to 256 
colors or more.

4. If the setting is less than 256 colors change it to 256 colors or 
more.

5. Click the ‘Apply’ button, then click ‘OK.’

If this does not solve your problem, or if the setting is already 256 
colors or more, then you should try any other available settings over 
256 colors to see if they solve your problem.

4.2.2 Checking your display adapter’s acceleration settings

1. If you have tried all the available Color Palette settings of 256 
colors or more, and none solve your problem, then you should 
click on the ‘My Computer’ icon using the right-hand mouse 
button, then select ‘Properties.’

2. In the ‘System Properties’ box you should click on the 
‘Performance’ tab.

3. In the ‘Advanced Settings’ box, click the ‘Graphics’ button.

4. In the ‘Advanced Graphics Settings’ box you should move the 
‘Hardware Acceleration’ slide-control down to ‘None’, then click 
‘OK.’

5. If this solves your problem you should try slowly increasing the 



‘Hardware Acceleration’ slider until you find the point nearest to 
‘Full’ at which your problem still remains solved.

6. If this does not solve your problem you should put the slider back 
to ‘Full.’ (You will need to try step 4.2.3.)

4.2.3 Changing your Display Adapter Driver

1. From the ‘Start’ menu, select ‘Settings’, then ‘Control Panel’

2. Double-click on the ‘Display’ icon, then click on the ‘Settings’ tab.

3. Click on the ‘Change Display Type’ button, then on the ‘Change…’
button under ‘Adapter Type.’

4. Click on ‘Show Compatible Devices.’

5. From the list shown ensure that the driver highlighted is the one to
match your display adapter. You can check this with your 
computer manufacturer or supplier. 

6. If the driver is not the correct one then you should ask your 
computer manufacturer/supplier to send you one.

In the mean time, or if you already had the correct driver installed, 
you can try installing the generic SVGA driver.

Note: users with S3 adapter cards should not do this as many of 
them are not compatible with the SVGA driver. 

1. From the ‘Start’ menu, select ‘Settings’, then ‘Control Panel.’

2. Double-click on the ‘Display’ icon, then click on the ‘Settings’ tab.

3. Click on the ‘Change Display Type’ button, then on the 
‘Change…’ button under ‘Adapter Type.’

4. Click on ‘Show All Devices.’

5. In the list of manufacturers, choose ‘Standard display types.’

6. In the ‘Models’ list-box, select ‘Super VGA’, then click ‘OK.’

If this does not solve your problem, if you have an S3 card, or if 
Super VGA was already the selected driver, then you should try the 
Standard display adapter (VGA.) To select this, use the same 



procedure as the Super VGA adapter, but select ‘Standard display 
adapter (VGA)’ from the ‘Models’ list-box.

If either the VGA or SVGA driver solves your problem, this shows 
that it was the original display adapter driver that you had installed 
that was causing the problem. The Standard (VGA) display adapter 
can not allow more than 16 colors to be displayed. Since Body 2.0 is 
designed to look its best in 256 colors or more. The long term 
solution to your problem would be to obtain the most up-to-date 
version of the drivers for your display adapter to see if they solve 
your problem - contact your computer manufacturer or supplier for 
these.

4.3 Solving problems with animation, video and WinG 
for Windows 3.1/3.11 users

4.3.1 WinG ( Windows Games Interface) error message

This product uses the WinG Windows Games Drivers. These are
installed during Setup. The first time you run Body 2.0, WinG 
‘profiles’ your display for optimum performance. This takes a couple 
of minutes and is only performed once. Certain older video display 
drivers are not compatible with WinG, in which case you get the 
following message when you start the product:

"WinG has encountered a problem with your video display driver.
Contact the manufacturer of your video card to obtain the most
recent driver. Your WinG applications will run, but at reduced
speed."

We recommend that you obtain and install the most recent driver
for your video card for best results, although installing the
standard Windows Super VGA 640 x 480 x 256 color driver works 
well on the machine configurations tested at DK Multimedia. We 
have included the generic Windows Super VGA driver, in the 
SUPPORT directory on the CD-ROM . This may be helpful but we 
should point out that it is not produced by DK Multimedia and is 
unsupported by us. If you have an S3 card, DO NOT install this 
driver as it is not compatible with S3 cards:

4.3.2 Installing the Microsoftâ Super VGA Driver

These instructions assume that you have version 3.1/3.11 of
Windows and a Super VGA compatible display adapter. If you are 
not sure, please refer to your display adapter documentation or ask 
your computer supplier or manufacturer. 



Please make sure that you have a back-up copy of your original
display drivers before installing the SVGA driver, in case you
need to reinstall them later.

This is how you install the SVGA driver:

1. In Windows ‘Program Manager’, double-click on ‘Windows
Setup’ in the ‘Main’ program group.

2. Select ‘Change System Settings...’ from the ‘Options’ menu.

3. Select ‘Other display (Requires disk from OEM.)..’ at the bottom of
the ‘Display’ drop-down list.

4. Type over the ‘A:\’ and replace it with ‘D:\SUPPORT\MSSVGA’
(where D is the letter of your CD-ROM drive.)

5. Select ‘Super VGA 640 x 480 256 colors’ and click on ‘OK.’

6. Make sure you exit Windows and restart.

For more information, check your Windows documentation, your 
display adapter manual, or contact your supplier.

4.3.3 Problems with Video or Animations

If you are running Body 2.0 under Windows 3.1/3.11 and have 
display problems, for example jumpy video or distorted colors, there 
are two main steps you can try to solve your problems. Try the steps 
in the order given and stop when your problem is solved:

- Ensuring your display is using 256 colors or more,
- Changing your display adapter driver.

However, if you have either a Diamond Stealth 64, Cirrus Logic 
542X, or Cirrus Logic 543X display adapter card, then you should go 
to the sub-section for that particular card and follow the instructions 
that appear there first. If these do not solve your problem, you should
return to this section and follow the instructions given here. If you do 
not know what type of display adapter card you have you can find 
out by doing the following:

1. In ‘Program Manager’, double-click on the ‘Main’ program group 
icon.



2.  Double-click on the ‘Windows Setup’ icon.

3. The text next to ‘Display’ in the window tells you the type of 
display adapter you have.

Ensuring your display is using 256 colors or more

1. Check to see if your display is using 256 colors or more. See 
section 3.2 for instructions on how to do this.

2. If the setting is less than 256 colors, change it 256 colors or more. 
Again, you should refer to your display adapter documentation to 
do this.

3. If this does not solve your problem, or if the setting is already 256 
colors or more, then you should try any other available settings 
over 256 colors to see if they solve the problem.

Changing your display adapter driver

If you have tried all the available color palette settings of 256 colors 
or more, and none solve your problem, then you should try changing 
your display adapter driver.

First check that the correct display adapter driver is installed. The 
name of the driver should match the name of your display adapter 
card. To do this:

1. In ‘Program Manager’, double-click on the ‘Main’ program group 
icon.

2. Double-click on the ‘Windows Setup’ icon.

3. The text next to ‘Display’ in the window tells you the name of the 
display adapter which is currently installed.

If the driver is not the correct one, then you should ask your 
computer manufacturer/supplier to send you the correct driver. 

In the mean time you can try installing the generic SVGA driver 
provided on the Body 2.0 disc to see if this solves your problem. 
Users with S3 display adapter cards should not do this, as many of 
these are not compatible with the SVGA driver. To install the SVGA 
driver follow the instructions which appear toward the beginning of 



the ‘Solving Problems with Animation, Video and WinG - Windows for
3.1/3.11 Users’ sub-section, under ‘Installing the Microsoftâ Super 
VGA Driver.’

If this does not solve your problem, if you have an S3 card, or if 
Super VGA was already the installed driver, then you should try the 
Standard display adapter (VGA):

1. From the ‘Program Manager’ double-click on the ‘Main’ program 
group icon, then double-click on the ‘Windows Setup’ icon. Click 
on the ‘Options’ drop-down menu, then click ‘Change System 
Settings…’

2. From the ‘Display’ list, select ‘VGA’, then click ‘OK.’

3. You should get a Change System Settings dialog box with the 
message “The driver for this display is already on the system. Do 
you want to use the currently installed driver or install a new 
driver?”. You should click the ‘Current’ button.

4. In the ‘Exit Windows Setup’ dialog box you should click the 
‘Restart Windows’ button.

If the standard VGA driver solves your problem, then try running 
Windows in Standard Mode by exiting and restarting it by typing 
‘WIN /S’ at the system prompt. If Body 2.0 works, then try running 
enhanced mode by exiting Windows and restarting it by typing 
‘WIN /D:XV’ at the system prompt. If this also solves the problems, 
then edit your SYSTEM.INI file’s ‘[386Enh]’ section so that these 
entries read:

EMMEXCLUDE=A000-EFFF
VIRTUALHDIRQ=OFF

If either the VGA or SVGA driver solves your problem, this shows 
that it was the original display adapter driver that you had installed 
that was causing the problem. The standard VGA display adapter 
can not allow more than 16 colors to be displayed. Since Body 2.0 is 
designed to look its best in 256 colors or more, the long term solution
to your problem would be to obtain the most up-to-date version of the
drivers for your display adapter to see if they solve your problem - 
contact your computer manufacturer or supplier for these.

4.3.4 Diamond Stealth 64 display adapter cards



Windows 3.1/3.11 users who have Diamond Stealth 64 display 
adapter cards and experience any of the following problems 

· Animation ‘shearing’ type effect
· Video not playing correctly when enlarged
· Video profiling crashing altogether
· Animation displaying offset from the correct position on 

the screen
· Monitor powers down and will not resume

should follow the instructions below. Try the steps in the order given 
and stop when your problem is solved:

The ideal solution to these problems would be to obtain the latest 
drivers from your computer manufacturer/supplier. For users of 
Diamond Stealth 64 DRAM cards we have included the latest drivers
on the Body 2.0 CD, and you should try installing these:

1. In Windows ‘Program Manager’, double-click on ‘Windows
Setup’ in the ‘Main’ program group.

2. Select ‘Change System Settings....’ from the ‘Options’ menu.

3. Select ‘VGA’ in the ‘Display’ section, then click ‘OK.’

4. A message will appear on the screen "A driver for this display is 
already on the system. Do you want to use the currently installed 
driver or install a new driver?". You should click ‘Current.’

5. Make sure you exit and restart Windows.

6. In the Windows ‘Program Manager’, select ‘Run’ from the ‘File’
menu.

7. Type in D:\SUPPORT\DIAMOND\INSTALL (where D is the letter of
your CD-ROM drive.)

Diamond have built in preference for older programs in their drivers. 
To bypass this, in order for animations and video to work properly in 
many of our programs, the following line in the ‘SYSTEM.INI’ file: 

"DEVICEBITMAPS=0" (in the [STLTH64.DRV] section) 

needs to be changed so that



“DEVICEBITMAPS=1”

If this section is missing altogether, it should be added.

To edit the ‘SYSTEM.INI’ file:

1. Select ‘File’ in ‘Program Manager’, then ‘Run.’

2. Type ‘SYSEDIT’ in the text box, then press return. Sysedit should 
load and you can select ‘SYSTEM.INI’ as the file to edit from the 
‘Window’ drop-down menu. Now edit the file:

(press enter)
[STLTH64.DRV] (now press enter)
DEVICEBITMAPS = 1 (now press enter)
(press enter again)

3. When you have finished editing the file, select ‘File’ then ‘Save’ to 
save your changes.

For users with Diamond Stealth 64 VRAM and Diamond Stealth 64 
Video VRAM cards a temporary solution may be the use of 65K color
mode,or disabling the video acceleration option. These can often 
help solve problems with video clips. To change the color mode:

1. In Windows ‘Program Manager’, double-click ‘Windows
Control Panel’ in the ‘Main’ program group.

2. Double-click the ‘InControl Tools’ Diamond icon.

3. Select the display button to see options for color depth, and
select ‘65K high color’ mode.

4. Click ‘OK’ when you have finished.

To disable the video acceleration option:

1. In Windows ‘Program Manager’, double-click ‘Windows
Control Panel’ in the ‘Main’ program group.

2. Double-click the ‘InControl Tools’ Diamond icon.

3. Make sure the box to the right of ‘Disable Video Acceleration’ is 
checked.

4. Click ‘OK’ when you have finished.



(NB: changing your video card driver and restarting Windows
AFTER you’ve installed Body 2.0 will result in the WinG ‘Profiling’ 
display running the first time you restart Body 2.0. Don’t be alarmed -
this only happens once and should not cause any problems.)

4.3.5 Cirrus Logic 542X Display Adapter Cards

Windows 3.1/3.11 users who have Cirrus Logic 542X display adapter
cards and who experience problems with animations or video should 
follow the instructions below to install the most up-to-date driver. This
is provided on the Body 2.0 CD-ROM. To install the driver:

1. In Windows ‘Program Manager’, double-click ‘Windows
Setup’ in the ‘Main’ program group.

2. Select ‘Change System Settings....’ from the ‘Options’ menu.

3. Select ‘VGA’ in the ‘Display’ section, then click ‘OK.’

4. A message will appear on the screen "A driver for this display is 
already on the system. Do you want to use the currently installed 
driver or install a new driver?". You should click ‘Current.’

5. Make sure you exit and restart Windows.

6. In the Windows ‘Program Manager’, select ‘Run’ from the ‘File’
menu.

7. Type in D:\SUPPORT\CIRRUS\INSTALL (where D is the letter
of your CD-ROM drive.)

4.3.6 Cirrus Logic 543X Display Adapter Cards

Windows 3.1/3.11 users who have Cirrus Logic 543X display 
adapters and experience the following problems:

· Animations and/or videos play with a distorted color pallet
· Animations and/or videos display blurred images or looks like a 

photographic negative.

should follow the instructions below. There are two steps to try:

1. Obtain the latest drivers



2. Change the color setting to 64k. 

Try the steps in the order given and stop when your problem is 
solved.

1. Obtain the latest drivers

The ideal solution to these problems would be to obtain the latest 
drivers from your computer manufacturer/supplier. 

2. Change the color setting to 64k

1. In ‘Program Manager’, double-click on the ‘VGAUtil’ program 
group icon.

2. Next double-click on the ‘WindMode’ icon and follow the 
instructions that appear on your screen.

3. Select ‘640 x 480’ from the list of available screen resolutions.

4. Select ‘65536’ (16 bit) from the list of colours available. 
Alternatively, you could select ‘16 Million’ (24 bit) if this option is 
available, however, this may result in a greater performance 
penalty. 

5 Audio problems

5.1 No sound output

The Ultimate Human Body contains an ambient sound track. By 
default this is turned off in the Options panel in the product. To switch
the ambient sound on simply click the check box on the Options 
panel labelled 'Ambient Sound' and then click 'OK'. On certain 
configurations, having the ambient sound on may cause problems.

There are many possible causes of audio problems. Remember, for 
example, that your computer can only play one sound at a time, so 
when another application is playing a sound Body 2.0 cannot do so. 
Most applications only prevent other programs from playing a sound 
when they themselves are doing so. However, some applications, 
such as certain Screen Savers, remove audio capability from all 
other Windows applications. If you have such an application you 
should turn it off when you are running Body 2.0. 

Also, Body 2.0 requires a sound card to be present, as all the 



animations in the product are synchronized to run frame-by-frame 
with their accompanying soundtrack. Therefore, Body 2.0 will not run 
without a sound card.

You should check that the speaker is hooked up to the jack on your 
sound card, and not hooked directly to the CD-ROM drive 
headphone socket. 

During Setup, special system software should be installed, and 
Windows should be restarted afterward to make this software work. If
you did not restart Windows, do so before attempting to run Body 2.0
again. However, if you are a Windows 95 user, and you get a 
message during Setup saying that audio or ADPCM drivers are 
already installed and asking you if you wish to replace them, you 
should choose not to replace them.

If you cannot hear sound in Body 2.0, you can test sound in the 
following way:

Windows 95 users
1. From the ‘Start’ menu, select ‘Settings’, then ‘Control Panel.’
2. Double-click on the ‘Sounds’ icon.
3. Click on any item with a speaker next to it, then click the ‘Preview 

button.

Windows 3.1/3.11 users
1. In ‘Program Manager’, choose ‘File’, then ‘Run.’
2. Type ‘chimes.wav’ in the text box, then click ‘OK.’

If you can hear sound, then there is some other problem with Body 
2.0. If you were not able to hear sound , you may not have the 
correct sound drivers installed. Check with your sound board 
manufacturer to see if you have the correct drivers and that there are
no hardware conflicts. If your sound board came with your computer, 
call your computer supplier.

5.2 Sound decompression drivers

If you encounter the following error message regarding your
sound software, do not worry:

“The sound software is not installed properly or has been disabled. 
For more information see the README file installed
with this program. This title will now terminate.”



The instructions which follow will help you to resolve this
problem. Separate instructions are given for Windows 95 and
Windows 3.1/3.11 users.

Windows 95 users:

1. From the ‘Start’ menu, select ‘Settings’, then ‘Control
Panel.’

2. From the ‘Control Panel’, double-click on the ‘Multimedia’
icon. The ‘Multimedia Properties’ dialog box should appear.

3. Click on the ‘Advanced’ tab, then click on the ‘+’ sign to
the right of ‘Audio Compression Codecs.

4. Double-click on the first Codec in the list. The ‘Properties’
dialog box for that Codec should appear.

5. Make sure that ‘Use this audio codec’ is selected. If it is
not, then you should click on the words ‘Use this audio
codec’ to select it. You MUST now click the ‘Apply’ button.

6. Follow the above instructions for each audio codec in the
list.

7. Now reinstall Body 2.0.

8. Make sure you restart your computer before attempting
to run Body 2.0 again.

Windows 3.1/3.11 users:

1. From the ‘Main’ program group in ‘Program Manager’,
double-click on the ‘Control Panel’ icon.

2. Now double-click on the ‘Sound Mapper’ icon. The ‘Sound
Mapper Configuration’ dialog box should appear.

3. Click on the first ‘Sound Mapper’ driver in the list. Now
click the ‘Priority’ button.

4. If the box to the left of the words ‘Disable Driver’ has a
cross in it, you should click it to remove the cross. Then click
‘OK’, and then click ‘OK’ again.



5. Follow the above instructions for each ‘Sound Mapper’
driver in the list.

6. Now reinstall Body 2.0.

7. Make sure you restart your computer before attempting
to run Body 2.0 again.

5.2.1 Incorrect Sound Decompression Drivers

The following problems may result from running Body 2.0 without the
correct sound decompression drivers:

· An error message concerning the sound decompression drivers
· (ADPCM) when you try to run the program.
· Unintelligible sound output from Body 2.0.
· Speeded up sound in some parts of Body 2.0 (but not in 

animations.)

Solutions for Windows 3.1/3.11 users:

If you are running Windows 3.1/3.11, to overcome any of these
problems you should:

1. Exit Windows, and in the Windows system directory you should 
rename the following files: ‘MSACM.DRV’ and ‘MSADPCM.DRV.’

2. Now restart Windows and run the ‘Setup’ program for
Body 2.0 again. Setup will enable the sound decompression 
drivers to be copied from the CD. Once Setup is completed, 
Windows must be restarted to complete the installation procedure.
The application should now run correctly.

Solutions for Windows 95 users:

If you are running Windows 95, to overcome any of these
problems, you should:

1. From the ‘Start’ menu, choose ‘Settings’, then choose ‘Control
Panel.’

2. Click the ‘Add/Remove Programs’ icon. The ‘Add/Remove
Programs Properties’ dialog box will appear.

3. Select the ‘Windows Setup’ tab.



4. Highlight the ‘Multimedia’ option in the list, then select the
‘Details’ button. The Multimedia dialog box will appear.

5. If the ‘Audio Compression’ box is not checked, you should do
this now. Click ‘OK’ and then follow the instructions that appear on
the screen.

6. If the ‘Audio Compression’ box is checked, you should click to
deselect it first. Select ‘OK’, and then follow the instructions that 
appear on the screen. Finally, repeat the whole operation to re-
check the ‘Audio Compression’ box. This ensures that the up-to-
date drivers are actually installed by Windows 95, and it doesn’t 
just ‘think’ they are.

If the above steps do not help, you should ensure that the Microsoft 
ADPCM driver is enabled. To do this:

1. From the ‘Start’ menu, choose ‘Settings’, then choose ‘Control
Panel.’

2. Click the ‘Multimedia’ icon. The ‘Multimedia Properties’ dialog
will now appear.

3. Select the ‘Advanced’ tab.

4. Click the ‘+’ symbol next to ‘Audio compression codecs.’

5. Click on the ‘Microsoft ADPCM’ codec, then click the ‘Properties’ 
button.

6. In the dialog box that appears, make sure that ‘Use this audio 
codec’ is selected.

If the above procedure does not solve your problem you may also
try the following steps to disable all CODECs listed which contain
the text ‘ADPCM’ (apart from the ‘Microsoft ADPCM CODEC’):

1. From the ‘Start’ menu, choose ‘Settings’, then choose ‘Control
Panel.’

2. Click the ‘Multimedia’ icon. The ‘Multimedia Properties’ dialog
box will now appear.

3. Select the ‘Advanced’ tab.



4. Select the CODEC you wish to disable, from the list.

5. Select the ‘Properties’ tab to display the dialog above to the
right.

6. Select ‘Do not use this audio codec.’

7. Select ‘OK.’ Repeat the procedure for all other relevant
CODECs.

If this does not work, you should remove all MSACM.* files under 
DOS from the following directories:

WINDOWS\SYSTEM\MSACM.*
WINDOWS\SYSBCKUP\MSACM.*

You should then re-install Windows 95.

5.3 Audio is fuzzy or distorted

There are a number of possible causes of fuzzy or distorted sounds. 
Problems are often caused by low quality speakers, speakers set to 
high or maximum volume, or speakers powered by batteries that are 
failing. You should also be aware that some speakers are not 
capable of playing low frequency sounds properly. If sound is 
interrupted, this may be caused by low memory - refer to section 7.

Some sound cards have software that allows you to adjust the 
volume AND tone of the sound. If this is the case with your sound 
card, start with these tone controls set in the mid position and your 
volume level set between 80% - 100%. This should give a clear 
signal with no distortion. Check your sound card manual for the 
optimum settings.

Powered speakers are best and, if possible, should be placed either 
side of the screen. You may need to adjust the position of these 
speakers slightly if the magnets in the speakers are unshielded and 
cause discoloration and distortion of the image.

If your CD-ROM drive is not MPC-compatible, then the sound may 
play badly or be interrupted when playing. Check your CD-ROM 
drvie’s documentation to ensure that it is a double-speed, or faster, 
CD-ROM drive.

5.4 Sound plays too quietly



Make sure that the volume is set to an audible level. Check the 
sound card itself, the speakers or headphones if they have a volume 
control, and any software that may have been supplied with your 
sound card that can change the volume level. If there is a mute 
button in the audio software or on the speaker, check that this is not 
activated.

If the sound controls are set to an audible level, then you may have a
problem with the way your sound card drivers are set up. Check they
are set up and, if necessary, reinstall them (To do this refer to section
4.2.) Consult your sound card documentation for more detailed 
information.

If you do not have a sound card installed on your PC and you are 
using the internal PC speaker driver, Body 2.0 will not work. You will 
need to install a sound card and sound card drivers to run the 
program.

5.5 EISA machines

If you are running Body 2.0 on an EISA machine, and the sound 
appears scratchy, change the DMA channel on the sound card to 
DMA 7. Consult your sound card documentation for more detailed 
information.

5.6 Media Vision sound cards

Please make sure that you have the latest drivers for your Media 
Vision sound card. Some earlier drivers cause problems for Body 
2.0. Contact Media Vision for current driver information.

6 CD-ROM problems

6.1 Care of compact discs

Contrary to early reports, compact discs (CDs) are very easily damaged if treated
carelessly. Such damage has a much greater effect on the digital data of a CD-
ROM than on the information of a music CD. A dirty or damaged CD-ROM is 
quite likely to malfunction. With CD-ROM drives becoming ever faster and more 
disc-sensitive, this is an increasing problem.



The surface of the disc can quickly gather dirt and is very easily scratched. To 
protect the data from scratches, finger-prints, dust particles, and smears, do not 
touch the readout side (unlabeled side) of the disc or place it face down on a 
hard surface.

Should the CD become dirty, clean it with a soft cloth lightly moistened with CD 
cleaning fluid or ethyl alcohol, working from the center to the edge. Do not use 
any type of solvent, such as benzine, lacquer thinner, anti-static agents or LP 
record cleaners as they may damage the surface.

Never leave the disc in a place subject to direct sunlight, high temperature or 
high humidity. Recommended storage conditions are:

· Temperature: 10ºC to 50ºC (50ºF to 122ºF)
· Humidity: 10 percent to 80 percent

6.2 Problems with CD-ROM drives

If Body 2.0 has problems finding the data files it needs from its CD-
ROM, you will see a message asking you to select the drive that 
contains the files. To find what has caused the problem, do the 
following:

1. Check that the Body 2.0 CD has been correctly inserted into the 
CD-ROM drive.

2. Check that Body 2.0 is looking in the right place for the CD-ROM 
drive. If, for example, the drive letter has changed as a result of a 
system change, such as adding or removing a RAM disk or 
another device, then Body 2.0 will fail to find its CD-ROM drive. 

3. If you have an external CD-ROM drive, ensure that it is plugged in,
turned on, and connected to your computer. You may need to 
check the documentation that came with the drive.

4. Verify that your CD-ROM drive is MPC-compatible and double-
speed or faster.

7 Running out of memory or running slowly

Body 2.0 uses your computer’s system memory to display pictures. If
you find that Body 2.0 runs slowly or if you come across out-of-
memory errors, the program probably does not have enough 
memory. Consider doing the following to improve your computer’s 



performance:

1. Close any unnecessary applications, including any DOS
Terminate and Stay Resident programs (TSR’s) you may have
installed.

2. If the program is still running slowly, you can improve its
performance by selecting the ‘Options’ screen from within
Body 2.0 and turning off ‘sound.’

3. Check that your computer has at least 8Mb of memory (12Mb 
recommended for Windows 95 users.) You can do this by leaving 
Windows, and typing ‘MEM’ at the system prompt. Look for total 
memory in the Total column. If the figure reads 8192Kb or more, 
then you have at least 8Mb of memory. If you have less than 8Mb 
(minimum 8192Kb) of memory, then you need to install some 
more.

4. Check that Windows has sufficient memory available for
Body 2.0. You can do this by selecting ‘About Program Manager’ 
from the ‘Help’ menu in Program Manager. If you are running 
Body 2.0 under Windows 95 you can do this by double-clicking on 
the ‘My Computer’ icon, then select ‘Help’, and then select ‘About 
Windows 95.’ The memory available should be a least 16384Kb 
(don’t be confused by looking for more memory in this step than 
you did in step 3 above. The extra memory here indicates the 
presence of a Windows swap file.) You may find more memory 
becomes available if you restart Windows. If the figure is less than
16384Kb this indicates that either you have no Windows swap file 
or that the swap file is too small. If this is the case, you should 
follow step 5 below.

5. If you are running Windows in Enhanced mode, set up a
permanent Windows swap file on your hard disk of a least
double the size of your installed RAM. You can do this by following
the instructions in your Windows documentation.

6. If you are running in color modes higher than 256 colors (8 bit), 
you should set your color mode to 256 colors. Refer to ‘Using 
more than 256 colors’ in section 3, ‘Screen Display Notes’, for 
instructions on changing the color mode.

7. On machines with only 8Mb of memory, restrict the SMARTDRV 
setting that controls the size of the disk cache for use inside 
Windows to 512K or less. If you are running Windows for 
Workgroups 3.11 and using 32-bit disk access, make sure that the



SMARTDRV settings in your AUTOEXEC.BAT file enable 
SMARTDRV to cache your CD-ROM drive efficiently. Consult your
Windows documentation for further information on how to check 
and adjust these settings.

8. If you are running DOS 6.0 or higher, then you can run the
MEMMAKER utility to optimize the memory in your computer. (For
example, if you answer ‘No’ to the question ‘Do you use any 
programs that need Expanded Memory?’, MEMMAKER will free 
further conventional memory by inserting the switch NOEMS in 
the appropriate line in your PC’s CONFIG.SYS file.) Consult your 
Windows documentation for further information on using 
MEMMAKER.

9. Speed up your hard disk by defragmenting it. There are a
number of tools available to carry out this task, including the
‘DEFRAG’ command found in MS-DOS version 6.0 and later.

10. Check that ‘MSCDEX’ which appears in the ‘AUTOEXEC.BAT’ 
file is version 2.23 or later, and appears before the ‘SMARTDRV’ 
entry. You can do this by typing ‘MSCDEX’ at the system prompt in
MS-DOS. If in no version number is given, then you can be sure 
that your version of ‘MSCDEX’ is older than version 2.23. Versions
of ‘MSCDEX’ older than 2.23 should be upgraded.

8 Printing

Printing screens from Body 2.0 may take several minutes, depending
on the type of printer you use. Since screen resolution and printer 
resolution are often different, the printout may not match the quality 
you see on the screen. 

If you are not happy with the position on the page or the size of your 
print out, try using the copy function to copy and paste the picture 
into another application such as a word processor or paint package, 
before printing.

You can change the settings of your printer from within Body 2.0 by 
clicking on the options icon, then by clicking on ‘Print Setup’ to 
display the ‘Print Setup’ dialog box. (Please note: an explanation of 
the Print Setup dialog box is available in your Windows 
documentation.)

Some dot-matrix printers may not print pictures properly with the 
‘Low / Faster’ quality setting in the ‘Print Setup’ dialog box. On these 



printers change the quality setting in the ‘Printer Settings...’ dialog 
box to ‘High / Slower.’

Because the pictures can be quite large, you may have difficulty 
copying or printing in low-memory conditions. In this case, follow the 
advice in section 7 of this file, and try again.

If any of the following printing problems occur:

· Nothing happens after the ‘Printing’ message
· Corrupt output
· Blank paper output

When any of these occur the following steps should be taken, in the 
order given. Stop when your problem is solved.

1. Try printing from a different application to see if all printing is 
affected. Also make sure that you have the correct driver - you 
should contact your printer manufacturer or vendor to check this.

2. Try different modes of printing, for example, different print quality 
such as draft, fine, line art. The options available will vary 
depending on the type of printer (check your printer Setup 
documentation for information on how to do this.)

3. Change the color depth used by the screen driver to 256 colors or 
more. Instructions for some driver types are given in section 3.

4. Ensure that ‘TEMP’ is set in the ‘AUTOEXEC.BAT’ file to a valid 
directory, for example, a line in the ‘AUTOEXEC.BAT’ could say 
‘SET TEMP=C:\WINDOWS\TEMP.’ This directory must exist and 
there must be room on your hard disk for this ‘temp’ file to be 
created.

5. Check your hard disk with the ‘Scandisk’ program, provided with 
DOS, and choose to repair all errors it flags. Then re-install the 
printer driver.

6. Obtain the most up-to-date printer driver available. Contact your 
printer supplier/manufacturer to do this.

7. Try another compatible printer driver.

9. Connecting to the Internet



Please note: If you would normally pay telephone charges to 
connect to your Internet Service Provider, or for the time that you use
the Internet, these charges will continue to apply while you are using 
the Online feature in this product. You should always ask permission 
from the person who will pay the bill before you use the Online 
feature described below.

If you are able to connect to the Internet from your computer, and if you have a 
Web browser installed, then you can take advantage of a feature Body 2.0 called 
Body Online. Body Online lets you access Body 2.0  Web pages on the Internet. 
If you do not have Internet access, or a Web browser, then you will NOT be able 
to make use of this feature.

Warning: If you are already connected to Body Online and try to connect again, 
then a second, concurrent browser session will be started. Each subsequent 
attempt to connect to Body Online will start a new, concurrent browser session – 
this is a feature of browsers. Running multiple sessions in this way may cause 
your computer to run out of memory and may result in your computer crashing. 
Therefore, we recommend that you run only one online session at a time.

Connecting to Body Online:

1. Click on the ‘Body Online’ button in the 3-D Lab. If you are not already in the 3-
D Lab, you will find it on the right-hand side of the screen.

2. Click on ‘OK.’ If an installed Web browser is detected on your machine you will
see a dialog box with the following message:

“You need to have a Web browser installed to connect to the Internet.
Your default Web browser is [name of default Web browser].
Do you want to use this?”

4. If you select ‘Yes’ then you should be automatically connected to the Body 
Online Web pages. Your Web browser name will be stored so that subsequent
connections to Body Online will happen automatically. If you select ‘No’, or if 
an installed Web browser was not detected on your machine, you will see a 
dialog box with the following message:

“ To use the online features in this title, you need to have a Web browser 
installed on your computer. If you do have a browser, click on ‘Locate’ to 
find it.

Otherwise, click on ‘Cancel’ and install a browser first.

See ‘Connecting to the Internet’ in the Readme file for more information”

5. If you’re thinking of clicking ‘Cancel’ because you’re not sure where your Web 



browser is located, you can try looking for it as described next:

Windows 95 users
a) Minimize the Body 2.0  program, then double-click on the ‘Start’ menu on 

the Task Bar.
b) Select ‘Find’, then ‘Files or Folders.’ The ‘Find’ dialog box will appear.
c) In the ‘Named’ text field try typing netscape.exe if your browser is 

Netscape Navigator™, or iexplore.exe if your browser is Microsoft Internet
Explorer™ (Be sure to look for iexplore.exe and NOT explore.exe.)

d) In the ‘Look in’ field, ensure your hard disk is selected.
e) Next click on the ‘Find Now’ button.
f) The location of your browser will be displayed in a window in the lower 

part of the dialog box.

Windows 3.1/3.11 users
a) From the ‘Main’ program group in Windows ‘Program Manager’, double-

click on the ‘File Manager’ icon.
b) In ‘File Manager’ double-click on the drive letter that represents your hard 

drive (this is normally C:.)
c) From the ‘File’ drop-down menu, select ‘Search.’ The ‘Search’ dialog box 

will appear.
d) In the ‘Search for’ text field, try typing netscape.exe if your browser is 

Netscape Navigator™, or iexplore.exe if your browser is Microsoft Internet
Explorer™ (Be sure to look for iexplore.exe and NOT explore.exe.)

e) In the ‘Start from’ field, type C: (where C: is the letter of your hard disk.)
f) Make sure the ‘Search all subdirectories’ box is checked.
g) Next click on the ‘OK’ button.
h) The location of your browser will be displayed if it is found.

6. If you still don’t know where to locate your browser, but know that you have a 
working Internet connection, you should click ‘Cancel’ then exit Body and 
connect to the Internet in your usual way. When you restart Body and try to 
connect to Body Online again, you will be presented with the dialog shown in 
step 7, stating that this product’s Internet address has been copied to the 
clipboard. 

If you choose ‘Locate’ you will see a ‘Please locate your Web browser .exe’ 
dialog box. You should locate and select the executable file of the Web 
browser that you wish to use, for example, netscape.exe or iexplore.exe (NOT 
explore.exe.) Be sure that you choose your Web browser .exe, and not 
another application.

7. From the ‘Please locate your Web browser .exe’ dialog box, if you choose 
‘Cancel’ you will see a dialog box with the following message:



“ The Internet Web site address for this product has been copied to the 
clipboard.

To use this address, connect to the Internet and run your Web browser 
software, then paste the Web site address into your browser’s Internet 
address field using Ctrl+V or Shift+Insert

If you would prefer to run your Web browser and locate this Web site 
automatically, please select ‘Online Setup’ in the Options screen.”

If you wish you can then start your Internet connection in your usual way and 
paste the Body Online Internet address into your browser. In Online Setup you
can configure Body to automatically open your Web browser and take you to 
the appropriate Body Web page when you click the Body Online button in the 
future. Online Setup is located in Options, which is accessed from the 
‘Options’ icon, located on the right-hand side of the screen.

From the ‘Please locate your Web browser .exe’ dialog box, if you choose 
‘Open’ you will see a dialog box with the following message:

“You have selected [name of your selection] as your Web browser.
If this does not work, use ‘Online Setup’ in options to change the setting.”

8. If you choose the ‘Back’ option you will be returned to the ‘Please locate your 
Web browser .exe’ dialog box. If you choose the ‘Finish’ option you should be 
connected to the Body Online Web page. The name of your Web browser 
selection will be stored for future sessions.

If your connection is not successful check the following:

· That you can connect to the Internet and use your browser in the 
normal way. If you cannot do this, then there is a problem with your 
Internet connection. For example, make sure that your modem is 
correctly connected and switched on.

· Try starting your Internet connection and Web browser first, and then 
start up Body 2.0 and try Body Online.

If you select the wrong .exe, or simply decide that you’d rather use a different 
browser from the one you selected, then you can select a different browser .exe 
by going to Online Setup. Online Setup is located in Options, which is accessed 
from the ‘Options’ icon, located on the right-hand side of the screen.
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